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บทที ่1 
การท าแผนที่โดยใช้อากาศยานไร้คนขับขนาดเล็ก 

1.1 อากาศยานไร้คนขับ (Unmanned Aerial Vehicle : UAV) 

อากาศยานไร้คนขับหรือยูเอวี (Unmanned Aerial Vehicle: UAV) เป็นอากาศยานที่ไม่มีนักบิน

ประจ าการอยู่บนเครื่อง เป็นอากาศยานที่ไร้คนขับหรือนักบินแต่สามารถควบคุมได้อากาศยานไร้คนขับมี

รูปร่าง ขนาด รูปแบบ และเอกลักษณ์ที่แตกต่างกันออกไป ตามหลักแล้วอากาศยานไร้คนขับ ก็คือ โดรน 

(Drone) นั่นเอง เป็นอากาศยานที่ควบคุมจากระยะไกล ใช้การควบคุมอัตโนมัติซึ่งมีอยู่  2 ลักษณะ คือ การ

ควบคุมอัตโนมัติจากระยะไกล และการควบคุมแบบอัตโนมัติโดยใช้ระบบการบินด้วยตนเองซึ่งต้องอาศัย

โปรแกรมคอมพิวเตอร์ที่มีระบบที่ซับซ้อนแล้วมีการติดตั้งไว้ในอากาศยานอาจกล่าวได้ว่า  อากาศยานไร้คนขับ

คือเครื่องบินที่สามารถบินได้ด้วยระบบอัตโนมัติ โดยไม่ต้องใช้นักบินประจ าการอยู่บนอากาศยาน อาจมีการ

ติดตั้งกล้องถ่ายภาพคุณภาพสูงทั้งกล้องถ่ายภาพในเวลากลางวัน (Electro Optical) และกล้องอิฟาเรด 

(Infrared Sensor) ที่สามารถบันทึกภาพระยะไกลได้แล้วแพร่ภาพสัญญาณมายังจอภาพ ที่สถานีภาคพื้นดิน 

ในเวลาที่ใกล้เวลาจริงมากที่สุด (Near Real Time: NRT)  

1.2 อากาศยานไร้คนขับขนาดเล็กแบบมัลติโรเตอร์ 

Multirotor UAVs เป็น UAV ประเภททีม่ีการใช้งานอย่างแพร่หลายมาก สามารถเคลื่อนที่ได้อย่าง

คล่องแคล่ว โดยมีหลายประเภทข้ึนอยู่กับขนาด และการใช้งานจะมีตั้งแต่ 4, 6, 8 และ 10 ใบพัด สามารถข้ึน

ลงในแนวดิ่ง โดยไม่ต้องใช้รันเวย์ในการขึ้นบิน แต่มีข้อจ ากัดตรงต้องใช้พลังงานมากในการบินท าให้มีข้อจ ากัด

ในด้านเวลา ท าให้บินได้ไม่ไกล ในปีที่ผ่านมาอากาศยานประเภทนี้ครองส่วนแบ่งการตลาดมากถึง 77%  

การบินของ Quadrotor จะการเคลื่อนที่ 4 ทิศทาง ทีเ่รียกว่า 4CH คือประกอบด้วย ขึ้น-ลง, เดินหน้า-

ถอยหลัง, เอียงซ้าย-เอียงขวา และ หมุนซ้าย-หมุนขวา และคล้ายกับ Quadrotor แบบ 6 ใบพัด 8 ใบพัด  โดย

มีรูปแบบการบิน 5 แบบดังต่อไปนี้ 

1) Hovering หรือ การลอยตัวเฉยๆ ท าได้โดยควบคุมให้ความเร็วใบพัดทั้งสี่ตัว มีความเร็วที่เท่ากันเพ่ือ

สร้างแรงบิดและหักล้างแรงบิด โดยใบพัดจะหมุนกันคนละทิศทาง ใบพัดหน้าและหลังจะหมุนตามเข็ม ส่วน

ใบพัดซา้ยและขวาจะหมุนทวนเข็ม ท าให้เครื่องบินไม่หมุนตัว 

2) Throttle  คันเร่ง ความเร็ว ให้เครื่องบิน บิน ขึ้นลง โดยใบพัดทั้งสี่ใบจะต้องเพ่ิมความเร็ว ทุก

ใบพัดที่เท่ากัน ท าให้เครื่องบินลอยตัวขึ้นได้ 
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3) Roll เอียงตัวซ้าย-ขวา โดบ ใบพัดหน้า (FRONT) และใบพัดหลัง (REAR) จะความเร็วเท่าเดิม แต่

ความเร็วใบพัดซ้าย (LEFT) จะหมุนเร็วขึ้น ทิศทางนี้จะยกตัว ใบพัดขวา (Right) จะช้าลงทิศทางนี้จะตกลง จึง

ท าให้เกิดการ เอียงตัวไปทางขวาได้ ส่วนเอียงตัวซ้ายหรือขวาได้  

4) Pitch เอียงหน้าและหลัง คล้ายกับการ Roll แต่เปลี่ยนเป็น ใบพัดซ้าย (LEFT) และใบพัดขวา

(RIGHT) จะความเร็วคงที่ แต่ความเร็วใบพัดหลัง (REAR) จะหมุนเร็วขึ้น ทางหลังจะยกใบพัดหน้า (FRONT) จะ

หมุนช้ากว่า ทางหน้าจะตก จึงท าให้เครื่องบินเอียงไปข้างหน้า 

5) Yaw หรือการหมุนตัว  ให้ความเร็วใบพัดหน้า (FRONT) – หลัง (REAR) มากกว่า ความเร็วใบพัด 

ซ้าย (LEFT) -ขวา (RIGHT) เพ่ือให้แรงบิดด้านซ้ายหรือขวามากกว่า จึงท าให้เครื่องบินหมุนตัวได้ 
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1.3 ส่วนประกอบของอากาศยานไร้คนขับขนาดเล็ก (Dji Phantom 4) 
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1.4  โหมดควบคุมการบิน 

P โหมด (Position) P โหมดจะท างานได้ดีเมื่อตัวเครื่องรับสัญญาณ GPS ได้ดี ตัวเครื่องจะใช้สัญญาณ 

GPS และเซนเซอร์บนตัวเครื่องเพ่ือรักษาต าแหน่งและสเถียรภาพของตัวเครื่อง และโหมดนี้เป็นโหมดที่แนะน า

ในการบังคับอากาศยานในภารกิจ 
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S โหมด (Sport) ข้อมูลและสัญญาณที่ได้รับขากตัวเครื่องจะถูกปรับเพื่อเพ่ิมความคล่องตัวของ

ตัวเครื่อง ความเร็วในการบินสูงสุดจะถูกปรับเป็น 72 กิโลเมตรต่อชั่วโมง แต่ระบบกันชนและเซนเซอร์ของ

ตัวเครื่องจะไม่ท างาน 

A โหมด (Attitude) ในโหมดนี้จะไม่ใช้สัญญาณ GPS ในการช่วยบิน แต่จะใช้เฉพาะค่าเพ่ือก าหนด

ต าแหน่งความสูงเท่านั้น 

 

ข้อควรระวัง 

• ในโหมด S ระบบกันชนด้านหน้าและด้านหนลังจะไม่ท างาน หมายความว่าตัวเครื่องจะไม่หลีกเลี่ยง

อุปสรรคและสิ่งกีดขวาง ควรระวังและหลีกเลี่ยงสิ่งกีดขวางในบริเวณใกล้เคียง 

• เมื่อตัวเครื่องมีความเร็วเพ่ิมข้ึนในโหมด S ระยะในการเบรกจะเพ่ิมข้ึนด้วย ระยะเบรกต ่าสุดในการใช้

ความเร็วสูงสุดในสภาพพ้ืนที่ ที่ไม่มีลมพัดจะมีระยะ 50 เมตร 

  

 

1.5 โปรแกรมท่ีใช้ในการควบคุมอากาศยานไร้คนขับขนาดเล็กเพื่อท าแผนที่ Dji Phantom 4 

 

 
 

 

ภาพที่ 1-3 Application ที่ใช้ในการควบคุมอากาสยานไร้คนขับขนาเล็กเพ่ือจัดท าแผนที่ 

 

 1.5.1 DJI GO 4 Application  

  ขั้นตอนที่ 1 การตั้งค่าอากาศยานไร้คนขับขนาดเล็กขั้นตอนที่ 1 ดาวน์โหลด DJI GO 4 

Application สามารถดาวน์โหลดได้ ทั้งระบบ ios และ android  ท าการเสียบสายเชื่อมระหว่างโทรศัพท์ กับ 
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รีโมทคอนโทรล จากนั้นกดเปิดรีโมทคอนโทรล และเปิดตัวอากาศยานไร้คนขับขนาดเล็ก ตัว Application จะ

เปลี่ยนจาก Enter Device เป็น GO FLY 

 

  
  

 

 
 

 ขั้นตอนที่ 2 เมื่อเปิดอากาศยานไร้คนขับขนาดเล็กเสร็จเรียบร้อย และกดค าสั่ง GO FLY จะเข้าสู่

หน้าจอภาพที่ถ่ายจากล้องบนอากาศยานไร้คนขับขนาดเล็ก โดยมีรายละเอียดบนหน้าจอดังต่อไปนี้ 

 ค าสั่งที ่ 1 Take of เป็นค าสั่งที่ท าให้อากาศยานไร้คนขับบินขึ้นแบบอัตโนมัติโดยอากาศยานจะบิน

ขึ้นทึความสูงประมาณ 1.5 เมตร 

 ค าสั่งที ่ 2 Return to Home เป็นค าสั่งที่ใช้เรียกอากาศยานไร้คนขับกลับมายังจุดปล่อยแบบ

อัตโนมัติ ตามความสูงที่ถูกตั้งค่าไว้ โดยอากาศยานจะบินกลับมาในระยะกระจัด 
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 ค าสั่งที ่3 คือค าสั่งการบินแบบอัจฉริยะ โดยผู้บังคับอากาศยานต้องตั่งค่ารีโมทคอลโทลในโหมด P  

 ค าสั่งที่ 4 ไอคอนสีแดง ตรงกลางใช้แทนอากาศยานไร้คนขับขนาดเล็กและหันไปทางไหน “N” ตัว

เล็ก ๆ ทางด้านซ้ายช่วยให้คุณรู้ว่าทิศเหนืออยู่ทางใดและเส้นแนวนอนสีน ้าเงินช่วยให้รู้ระยะห่างของจุดปล่อย

อากาศยาน  

  ค าสั่งที่ 5 “ D” หมายถึงระยะทาง ที่อากาศยานไร้คนขับอยู่ห่างจากปล่อย และ “H” หมายถึง

ความสูงของอากาศยานไร้คนขับ โดยสามารถเลือกหน่วยได้ท้ังฟุตและเมตร 

ค าสั่งที่ 6 “ H.S”  หมายถึงความเร็วในการเคลื่อนที่ในแนวราบ และ “V.S” ย่อมาจากความเร็วใน

การเคลื่อนที่ในแนวตั้งซึ่งเป็นความเร็วในการขึ้นหรือลงของโดรน 

ค าสั่งที่ 7 VPS ย่อมาจากระบบก าหนดต าแหน่งการมองเห็น กล้องขนาดเล็กที่ด้านล่างของอากาศ

ยานไร้คนขับจะช่วยให้คุณสามารถวัดระยะทางไกลได้หากคุณอยู่ในระดับต ่าพอที่ VPS จะท างานได้ (โดยทั่วไป

จะต ่ากว่า 30 ฟุต)  

ค าสั่งที่ 8 คือจุดแสดงว่ากล้องก าลังโฟกัสไปยังจุดได้บนภาพ สามารถแตะบนหน้าจอเพื่อเปลี่ยนจุด

โฟกัสที่ต้องการได ้

ค าสั่งที่ 9 คือเซ็นเซอร์ที่ใช้หลบหลีกสิ่งกีดขวางรู้และแสดงระยะห่างระหว่างอากาศยานกับวัตถุ

ด้านหน้า โดยแสดงเป็นแถบสีเขียวและสีเหลืองในภาพด้านบนและเมื่อเข้าใกล้วัตถุมากขึ้นแถบจะเปลี่ยนเป็นสี

แดงและเริ่มส่งเสียงบี๊บเพื่อแจ้งให้ทราบว่ามีบางอย่างอยู่บนเส้นทางการบิน 

ค าสั่งที ่ 10 แสดงสถานะของการตั้งค่ากล้อง 

ค าสั่งที ่11 แสดงความจุที่เหลืออยู่ในการ์ด SD ขณะบันทึกด้วยการตั้งค่าปัจจุบัน 

ค าสั่งที่ 12 สามารถเลือกจุดโฟกัสสีเขียวตรงกลางหน้าจอและวงกลมแสงสีเหลือง ด้วยกล่องโฟกัส

สามารถแตะบนหน้าจอเพ่ือให้ตรงกับจุด 

ค าสั่งที่ 13 สามารถเลือกระหว่างโฟกัสอัตโนมัติและโฟกัสด้วยตนเอง เพียงแค่แตะบนพื้นที่ของ

หน้าจอที่คุณต้องการให้กล้องโฟกัส  

ค าสั่งที ่14 การล็อคค่าแสงอัตโนมัติ สิ่งนี้จะล็อกค่าการเปิดรับแสง 

ค าสั่งที ่15 คือวิธีสลับระหว่างการถ่ายวิดีโอและการถ่ายภาพ 

ค าสั่งที ่16 จุดเส้นประแนวตั้งแสดงมุมเอียงของ gimbal  
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Application Pix4Dcapture 

ค าสั่งที ่17 กดที่นี่เพ่ือเริ่มและหยุดวิดีโอและเพ่ือจับภาพ และสามารถใช้ปุ่มถ่ายภาพบน RC เพ่ือท าสิ

ได้เช่นกันซึ่งจะสะดวกกว่าการกดผ่านบนหน้าจอ 

ค าสั่งที ่18 โหมดการตั้งค่าวีดีโอ 

ค าสั่งที ่19 ไปที่นี่เพ่ือดูภาพและวิดีโอที่คุณถ่าย 

 

 1.5.2 Pix4Dcapture Application  

   ขั้นตอนที่ 1 ดาวน์โหลด Application Pix4D Capture                สามารถดาวน์โหลดได้ 

ทั้งระบบ ios และ android  จากนั้นเปิด Application Pix4D Capture ขึ้นมาเพ่ือตั้งค่าอากาสยานไร้คนขับ

ขนาดเล็ก 
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ขั้นตอนที่ 2 เลือกค าสั่ง Settings จากนั้นเลือกอากาศยานไร้คนขับให้ตรงกับรุ่นที่ใช้งาน ในหัวข้อที่

เขียนว่า Drone และให้เลือกหัวข้อ Units ให้เปลี่ยนจาก Feet เป็น Meter เพ่ือให้ง่ายต่อออกแบบขนาดของ

แนนวการบิน เมื่อตั่งค่าเสร็จแล้วให้เลือกค าสั่ง Close เพ่ือกลับสู่หน้าจอหลัก 

 

 

 

 

 

 

 

 

  

 

ขั้นตอนที่ 3 หลังจากตั้งค่าเสร็จแล้ว ผู้ท าการบินสามารถเลือกรูปของการบินได้ ทั้ง 4 แบบได้แก่ 

 1) การวางแผนการบินแบบ Polygon Mission คือการออกแบบแนวการบินให้เสมือนกับ

ขอบเขตแลงส ารวจ 

 2) การวางแผนการบินแบบ Grid Mission แผนการบินที่ถูกสร้างข้ันจะอยู่ในรูปแบบ สี่เหลี่ยม 

โดยผู้ท าการบินต้องวางแผนการให้เกินกว่าขอบเขตพ้ืนที่ส ารวจ 

 3) การวางแผนการบินแบบ Double Grid Mission คือการวางแผนแนวบินแบบ Grid 2 

ซ้อนทับกันเหมาะส าหรับการสร้างแผนที่ในรูปแบบ 2.5 มิติ 
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 4) การวางแผนการบินแบบ Circular Mission คือการบินในรูปแบบวงกลมโดยปรับความ

ละเอียดของการถ่ายภาพตามองศาของวงกลมเหมาะกับการถ่าย ภาพแบบ 3 มิติ 

 

 
 

  

  
 

ขั้นตอนที่ 4 ยกตัวอย่างการบินถ่ายภาพในรูปแบบ Grid Flight ต้องมีการตั้งค่ากล้องให้ถ่ายภาพ

อัตโนมัติ จึงจ าเป็นต้องมีการก าหนดความสูงในการบิน ก าหนดขนาดของพื้นที่ส ารวจ และ ส่วนซ่อนทับของ

ภาพ ทั้งนี้การก าหนดความสูงควรค านึงถึงสิ่งกรีดขวาง และระดับภูมิประเทศของพื้นที่การส ารวจ ควร

ก าหนดให้ polygon (พื้นที่สีเขียว) เกินขอบเขตพื่นที่ ที่ต้องการจะส ารวจจากนั้นกดค าสั่งSTART อากาศยาน

ไร้คนขับจะท าการบินขึ้นแบบอัตโนมัติ (ข้อควรระวังผู้ท าการบินต้องเลือกวางอากาศยานไร้คนขับในพื้นที่

เปิดโล่งพ่ือลดความเสี่ยงในการเกิดอุบัติเหตุ) 
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 1.5.3 Dronedeploy Application  

  ขั้นตอนที่ 1 ท าการดาว์โหลดและติดตั้ง Dronedeploy Application สามารถดาวน์โหลดได้ 

ทั้งระบบ ios และ  android  จากนั้นท าการเปิด Dronedeploy Application ขึ้นมาและท าการลงทะเบียน

เข้าใช้งาน  

 

 
 

  ขั้นตอนที่ 2 ท าการสร้าง Project โดยสามารถค้นหาข้อมูลพ้ืนทีท่ี่ต้องการท าการบินได้จาก

ช่อง Search by Name เมื่อได้พ้ืนที่ที่ต้องการส ารวจ แล้วให้กด  Create project here จากนั้นให้ท าการสร้าง

ชื่อ Project และเลือกค าสั่ง Continue เพ่ือออกแบบแนวการบิน 

ขนาดพื้นท่ี เวลา 

ขนาด GSD 

ความสูง 
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 ขั้นตอนที่ 3 ท าการแก้ไขขอบเขตพ้ืนที่การบิน ตั้งค่าการบินแบบอัตโนมัติ   และปรับ

ค่าพารามิเตอร์ เช่น ความสูงในการบิน ค่าการซ้อนทับของภาพด้านหน้าของแนวบิน  ค่าการซ้อนทับของภาพ

ด้านข้างของแนวบิน  ความเร็วในการบิน ซึ่งทั้งหมดนี้จะมีผลต่อจ านวนของรูปภาพและความคมชัดของ

ภาพถ่ายทางอากาศ 

 

 
 

 



15 

 

 

บทที ่2 

กระบวนการท าการแผนที่รายละเอียดสูงจากอากาศยานไร้คนขับขนาดเล็ก 

2.1 การท าจุดควบคุมภาคพื้นดิน Ground Control Points 

           Ground Control Points (GCPs) คือ จุดที่เก็บข้อมูลเชิงต าแหน่งที่ไดม้าจากพื้นที่ซึ่งค่าพิกัด
น้ันได้มาจากเครื่องรังวัดระบบ GNSS RTK หรอื จากแหล่งข้อมลูอื่นๆ ซึง่ค่า GCPs น้ีไม่จ าเป็นต้องใช้ใน
การประมวลผลในโปรแกรมประมวลผลภาพ แต่จะเป็นตัวที่เพิ่มความถูกต้องเชิงต าแหน่งให้กับแผนที่
รายละเอียดสูง และสามารถใช้เป็นจุด Checkpoints เพื่อตรวจสอบความถูกต้องของผลลัพธ์ 

การวางจุดควบคุมภาคพื้นดินหรือ GCPs ควรมีอย่างน้อย 6 จุดในพื้นที่ที่ท าการวางแผนการบินเพื่อ
ถ่ายภาพและควรวาง GCPs ให้ครบทุกมุมของพื้นที่ส ารวจ หากสามารถวางจุด GCPs  ไดก้ระจายในพื้นที่
อย่างเท่า  ๆ  กันจะท าให้แผนที่ที่ผ่านการปรับค่าเชิงต าแหน่งน้ันมีความสมบูรณ์ในทุกส่วนของภาพถ่ายทาง
อากาศ 
 

 
 

ภาพที่ 2-1 การวางจุดควบคุมภาคพ้ืนดิน 
 

2.2 การออกแบบการวางแผนการบิน เพื่อให้ได้แผนที่ที่มีความสมบูรณ์ 
        1) พ้ืนที่ที่ต้องการส ารวจ 
        2) ชนิดของพ้ืนผิว และวัตถุที่ต้องการถ่ายภาพ 

3) การค านวณความละเอียดของจุดภาพ (GSD) 
4) การออกแบบแผนการบินให้เหมาะกับพื้นท่ีส ารวจ 
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ชนิดของพื้นผิว หรือวัตถุ 
 ในการถ่ายภาพเพ่ือท าแผนที่ ที่มีคุณภาพจ าเป็นต้องค านึงถึงลักษณะของพ้ืนที่เราจะถ่าย ยกตัวอย่าง 
เช่น การถ่ายภาพบริเวณพ้ืนที่เป็นน ้า จะสามารถท าการต่อภาพไม่ได้เนื่องจาก น ้านั้นพื้นผิวมีความคล้ายกัน
ทั้งหมด ท าให้คอมพิวเตอร์ไม่สามารถแยกความแตกต่างได้ ดั้งนั้นการถ่ายภาพบริเวณพ้ืนที่ที่เป็น บ่อน ้าหรือ 
แหล่งน ้าอาจจะปรับแก้ด้วยการปรับเพดานบินให้สูงขึ้น 
 
ความละเอียดของภาพ 
 ขนาดวัตถุนั้นมีความส าคัญอย่างยิ่งต่อการถ่ายภาพทางอากาศ เพราะความละเอียดของกล้อง 
ความเร็วในการถ่ายภาพแบบต่อเนื่อง นั้นมีความสัมพันธ์ต่อความเร็วในการบินโดรน และความละเอียดของ
จุดภาพ ซึ่งสามารถค านวนผ่านสมการ Ground Sample Distance (GSD) นี้ได้ 
 

𝐺𝑆𝐷

𝑝𝑖𝑥𝑒𝑙𝑠𝑖𝑧𝑒
 = 

𝐴𝑙𝑡𝑖𝑡𝑢𝑑𝑒

𝑓𝑜𝑐𝑎𝑙
                                 

 

 

2.3 ประเภทของการท าแผนที่ด้วยอากาศยานไร้คนขับขนาดเล็ก 

1) การท าแผนที่เพื่อการส ารวจพื้นที่เกษตรกรรม 

ในการท าแผนที่เพื่อติดตามการเปลี่ยนแปลงของข้อมูลพื้นเกษตรเพื่อเพิ่มประสิทธิภาพการผลิต ลด
ต้นทุนการผลิต ประหยัดเวลาและแรงงานคน นอกจากนี้ยังสามารถควบคุมคุณภาพการผลิตได้อย่างแม่นย า
โดยการวางแผนการบินส าหรับพืชเกษตรควรออกแบบความสูงการบินให้ตรงกับการเจริญเติบโตของพืช ใน
กรณีที ่ภูมิประเทศมีลักษณะเป็นพื้นที ่เรียบราบ เช่น พื ้นที ่เกษตรกรรมต่างๆ จะท าการแบ่งแยกจุดที่มี
ลักษณะเฉพาะได้ยากมาก เพราะภูมิประเทศมีลักษณะเหมือนกันหมดทั่วทั้งพื้นที่  ในการที่จะได้ผลลัพธ์ที่ดีมา
นั้น ควรบินแบบ Double Grid เพ่ือได ้DSM ที่มีความแม่นย าใช้ในการรังวัดความสูงของพืชได้ดี 

โดยที่ GSD คือ ตัวเลขระยะบอกขนาดความละเอียดของจุดภาพ cm/pixel 

 focal คือ ความยาวโฟกัสของเลนส์ (mm) 

 Altitude คือความสูงในการบิน (m) 

 pixelsize คือขนาดของจุดภาพ (μm) 
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 - เพ่ิมการ Overlap ระหว่างรูปภาพเป็นอย่างน้อย 85%  frontal overlap และอย่างน้อย 70% 
side overlap 
 - บินให้ต ่าลงเพ่ือให้คุณภาพของภาพถ่ายและท าให้ได้ภาพที่มีความคมชัดมากยิ่งข้ึน 
  

 
 

 

2) การท าแผนที่เพื่อส ารวจแนวถนน แนวสายไฟ และการส ารวจแนวชายฝั่งทะเล 

การท าแผนที่เส้นทางเดินทาง เช่น ทางรถไฟ, ถนน, แม่น ้า จ าเป็นต้องมีอย่างน้อย 2 เส้นแนวการบิน
ส าหรับ Dual track (เส้นทางคู่) ควรใช้ overlap อย่างน้อย 85%  frontal overlap และอย่างน้อย 70% 
side overlap สามารถใช้ภาพทางอากาศมุมต ่าๆ หรือ ภาพมุมเอียง (มุมระหว่าง 0-45 องศา ผ่านเส้นทางทั้ง 
2 ไปถึงจุดกึ่งกลางของเส้นทางเดินทาง) ส าหรับภูมิประเทศราบเรียบควรใช้ภาพทางอากาศมุมต ่าๆ (nadir 
images)   

- ค่า Overlap : อย่างน้อย 85% frontal overlap อย่างน้อย 70% side overlap 
- การวาง GCPs ควรวางแบบซิกแซกตามแนวความยาวของพ้ืนที่ส ารวจ 
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3) การท าแผนที่เพื่อส ารวจพื้นทีเ่หมืองแร่  

การท าแผนที่เหมือแร่ควรค านึงถึงความสูงของภูมิประเทศ การที่จะท าให้ได้ข้อมูลที่ความแม่นย าและ

ถูกต้องรายละเอียดของจุดภาพ (GSD) ไม่ควรเกิน 5 เซนติเมตร ควรบินในรูปแบบ Double Grid images จะ

ท าให้ได้ที่มีความถูกต้องของค่า Z นั้นสูงขึ้น  

- ค่า Overlap : อย่างน้อย 80% frontal overlap อย่างน้อย 60% side overlap

4) การท าแผนที่เพื่อส ารวจพื้นที่ป่าไม้

ต้นไม้และป่าไม้ มักจะมีความแตกต่างกันมาก ระหว่างภาพที่ overlap กัน อ้างอิงจากความซับซ้อน
ทางธรณีวิทยา (กิ่งไม้และใบไม้นับพันๆ) อย่างไรก็ตามก็ยังเป็นเรื่องยากท่ีจะแยก common characteristic 
point ระหว่างรูปภาพ ในการที่จะได้ผลลัพธ์ที่ดีมานั้น ควรจะใช้ grid images acquisition plan เหมือนกับที่
อธิบายใน General case โดยมีการเปลี่ยนแปลงดังนี้ 

- เพ่ิมการ Overlap ระหว่างรูปภาพเป็นอย่างน้อย 85%  frontal overlap และอย่างน้อย 70% side
overlap 

- เพ่ิมความสูงบิน ที่ระดับความสูงที่สูงกว่า ภาพจะมีมุมมองที่บิดเบือนน้อยกว่า (แต่จะมีปัญหาเรื่อง

การปรากฏของภาพ) และพ้ืนที่ป่าไม้จะมีคุณสมบัติของมุมมองที่ดีข้ึน อีกนัยหนึ่ง ที่ความสูงบินที่สูงกว่าจะท า

ให้การตรวจจับหาจุดที่เหมือนกันของภาพ 2 ภาพ ที ่Overlap กันในพ้ืนที่ๆหนึ่งมีความง่ายมากขึ้นความสูงบิน

ที่ม ี image pixel resolution และ focal length อยู่รวมกันจะใช้หาค่า Ground Sampling Distance 

(Spatial resolution : ความละเอียดเชิงพ้ืนที่) ของรูปภาพ การที่จะได้ผลลัพธ์ภาพที่ดีที่สุดจะต้องมีค่า GSD 
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สูงกว่า 10 pixel/cm ส าหรับข้อมูลเพ่ิมเติมเก่ียวกับการปรับปรุงผลลัพธ์รูปภาพที่เป็นพ้ืนที่ป่าไม้ โดยเลือกใช้

การประมวลผลที่ถูกต้อง 

5) การท าแผนที่เพื่อส ารวจอาคารสูง

การปรับสภาพอาคาร 3 มิติ ต้องใช้ image acquisition plan แบบเฉพาะ (ตามรูปที่ 4) 
- บินรอบๆอาคารครั้งแรกด้วยกล้อง a45 camera angle
- บินครั้งที ่2 และ3 รอบๆอาคาร โดยเพิ่มความสูงบิน และลดมุมกล้องในแต่ละรอบ

หมายเหตุ : ส าหรับข้อมูลเพิ่มเติมเก่ียวกับ Oblique imagery 
ควรถ่ายรูปทุกๆ 5-10 องศา เพ่ือให้ได้ overlap ที่เพียงพอ ขนาดของวัตถุและระยะทางจะถูกน ามาคิด ถ้าระยะ
สั้นและขนาดวัตถุใหญ่ จะต้องใช้รูปที่มีองศาน้อยลง 
หมายเหตุ : สูงบินไม่ควรเพิ่มข้ึนเกิน 2 เท่าของระยะระหว่างสายการบิน ซึ่งความสูงที่ต่างกันจะท าให้ความ
ละเอียดเชิงพ้ืนที่ (Spatial Resolution) ต่างกันด้วย ส าหรับข้อมูลเพ่ิมเติม  
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บทที ่3 
การประมวลผลภาพด้วยโปรแกรม Agisoft PhotoScan Professional Edition 

3.1 การเลือกภาพเพื่อใช้ประมวลผลภาพถ่ายทางอากาศ 
 1) ภาพที่ใช้ในการประมวลผลไม่ควรมีสัญลักษณ์ใดๆ อยู่ในภาพ เช่น เวลา ตราประทับวันที่รูปภาพที่
มีสัญลักษณ์ดังกล่าวไม่สามารถน าไปประมวลผลได้ 
 2) ภาพที่ใช้ไม่ควรจะมีการปรับแต่งเช่น ท าให้ไฟล์ภาพไม่มีขนาด การหมุนภาพ ห้ามใช้ภาพที่ถ่ายใน
ช่วงเวลาที่อากาศยานก าลังบินขึ้นหรือลงจอด และขณะที่อากาศยานก าลังหมุน 
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3.2 การสร้างไฟล์งานบนโปรแกรม Agisoft PhotoScan 

 เมื่อท าการติดตั้งโปรแกรม Agisoft PhotoScan เสร็จเรียบร้อย จากนั้นเปดิตัวโปรแกรมขึ้นมา แล้วกดค าสั่ง  Workflow แล้ว

เลือกค าสั่ง Add photos  ภาพที่ถูกน าเข้ามาจะไปอยู่ที่หน้าต่าง Work space ใน Chunk ซึ่งอาจจะมีหลาย Chunk ก็ได้ขึ้นอยู่กบจ านวน

รอบบินของอากาศยานไร้คนขับ และจ านวนรูปภาพ 

 
พ่ี 

 

 

 

 

กดเลือกค าสั่ง Workflow 

กด CTRL+A เพื่อรูปภาพทั้งหมด 

จากน้ันกด Open 

กดเลือกค าสั่ง Workflow 
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3.3 การท าขั้นตอน Align Photos 

 หลังจากสร้างชุดข้อมูลเพื่อใช้ในการประมวลผลแล้วนั้น เราจะมาเริ่มประมวลผลภาพ โดยจะเลือก

ค าสั่ง workflow โดยจะเห็นได้ว่ามีข้ันตอนต่างๆเริ่มตั้งแต่ Align Photo จะมีตัวหนังสือสีด าและตัวอ่ืนๆเป็นสี

เทา หมายความว่า เราต้องท าการประมวลทีละขั้นตอนโดยเริ่มจากค าสั่ง Align Photo เป็นอันดับแรก 

 
 

 คลิกท่ี Align Photo จะได้หน้าต่างแบบนี้ดังภาพที่ 3-5 ซึ่งก็จะสามารถเลือกค่าฟังก์ชั่นหรือความ

ละเอียดต่างๆได้ ตามความต้องการของงาน โดยขั้นตอนนี้จะเป็นขั้นตอนการน าภาพมาจัดเรียงแล้วเลือกเอา

จุดของภาพที่เหมือนกันมาสร้างโมเดล 

 
 

 

กด Align photos เพื่อการ

ประมวลผลภาพ 

ตั้งค่า Accuracy จากน้ันกด oK 
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 การตั้งค่า Accuracy ก็จะมีให้เลือกทั้งหมด 5 แบบ แสดงถึงความถูกต้องและความละเอียดของงานที่

ผู้ประมวลผลต้องการ 

o Highest จะมีความถูกต้องของจุดข้อมูลสูงสุด ท าให้ใช้เวลาโปเสสนาน 

o Lowest จะมีความถูกต้องต ่าสุด ใช้เวลาน้อยที่สุด 

 การเลือก Accuracy นั้นขึ้นอยู่กับว่าผู้ประมวลผลภาพต้องการความละเอียดของภาพ Orthomosaic 

สูงหรือต ่าโดยถ้าต้องการสูงให้เลือก Highest หรือ Hight แต่ถ้าไม่ต้องการภาพที่คมชัดมากให้เลือก Medium 

หรือ Low ไม่แนะน าให้เลือก Lowest เพราะภาพที่ได้คุณภาพจะแย่เกินไป 

 

3.4 การทขั้นตอน Dense Cloud 

 หลังจาก Align photo เสร็จแล้วควร save งานก่อน หนึ่งครั้งโดย ไปทีค่ าสั่ง file>save as เลือกที่

เก็บแล้วกด save จากนั้นไปที่ Workflow จะเห็นว่าบรรทัดถัดไปจะมีตัวหนังสือสีด าเพ่ิมขึ้นมา แสดงว่าเรา

สามารถท าขั้นตอนต่อไปได้โดยเราจะท าขั้นตอน Dense Cloud ก่อน เพ่ือเพ่ิมจ านวนจุดของ Title point ให้

มากขึ้นก่อนที่จะไปสร้างพ้ืนผิวในขั้นตอน Mesh หรือถ้าคิดว่ามีจ านวน title point มากพอแล้วเราสามารถ

ข้ามขั้นตอนไปท า mesh ได้เลย 

 
 

กด Build Dense Cloudเพื่อการ

ประมวลผลข้อมูล Cloud 
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การตั้งค่าค าสั่ง Quality จะมีให้เลือก 5 แบบ แสดงถึงความละเอียดของจุดที่ต้องการเพ่ิมข้ึนมา 

o Ultra High จะมีความละเอียดของจุดข้อมูลสูงสุด ท าให้ใช้เวลาในการโปรเสสนานมาก 

o Lowest จะมีความละเอียดต ่าสุด ใช้เวลาค านวณน้อยที่สุด 

การตั้งค่าค าสั่ง Depth fitering มีให้เลือกอยู่ 4 แบบ ซึ่งแต่ละแบบก็จะมีความต่างกัน 

o Disabled แบบทั่วไปไม่เจาะจง มีการเพ่ิมจ านวนจุดขึ้นมา 

o Mild จะเป็นการเพ่ิมรายละเอียดไม่มากจนเกินไปเน้นให้ผิวเรียบสมูท 

o Moderate จะเป็นการเพ่ิมจ านวนจุดให้พอดีสม ่าเสมอท าให้ข้อมูลไม่ขรุขระจนเกินไป 

o Aggressive จะเป็นการลงรายละเอียดเพ่ิมจุดให้เยอะๆ มีความละเอียดสูงแต่ถ้าข้อมูลไม่

เพียงพออาจท าให้ผิดเพ้ียนได้  

 
 

 

 

 

ตั้งค่า Build Dense Cloud  

จากน้ันกด OK 
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3.5 การท าขั้นตอน Build Mesh 

 หลังจากเสร็จกระบวนการ Dense Cloud แล้วนั้นขั้นตอนต่อไป คือการสร้างข้อมูล Mesh โดยเลือก

ค าสั่ง Build Mesh  

 
 

การตั้งค่าค าสั่ง Surface type จะมีให้เลือก 2 แบบ คือ 

o Height field จะค านวณภาพพ้ืนผิวแบบระนาบตั้งฉากภูมิประเทศ มองจาก top view 

เหมาะส าหรับท าแผนที่ ภูมิประเทศ เพราะใช้ RAM น้อย ค านวณเสร็จไวกว่าแบบ Arbitrary 

o Arbitrary จะใช้การค านวณพ้ืนผิวในทุกทิศทุกทางเพ่ือให้โมเดลมีความราบเรียบ เหมาะ

ส าหรับท าโมเดลวัตถุ หรือโมเดลปิดเป็นรูปร่าง แต่ใช้ RAM มากใช้เวลาในการค านวณนาน 

การตั้งค่าค าสั่ง Source data แหล่งที่มาของข้อมูลเลือกเอาว่าจะเอาจุดจากข้อไหนมาสร้างพ้ืนที่ผิว 

o Sparse Cloud จะน าข้อมูลจาก title point จากข้ันตอน align photo 

o Dense Cloud จะน าข้อมูลจากข้ันตอนก่อนหน้ามาค านวณ 

Face Count ก็ให้เลือกความละเอียดของพ้ืนผิวโดยจะบอกจ านวนโดยประมาณของหน้าโครงข่ายที่เชื่อมโยง

กัน ระหว่างจุดแต่ละจุด 

Interpolation เป็นการปรับแก้พ้ืนผิวข้อมูลโดยการประมาณค่า 

กด Build Mesh เพื่อการประมวลผลข้อมูล 

Mesh 
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o Disabled จะเป็นการเพ่ิมจุดเพ่ือให้พ้ืนที่ผิวสอดคล้องกับความเป็นจริง 

o Enabled (default) จะเป็นการปรับความเหมาะสม ถ้าพ้ืนที่ตรงไหนมีจุดเพียงพอก็จะไม่

สร้างเพ่ิม 

o Extrapolated จะเป็นการขยายขนาดรัศมีของจุดแต่ละจุดให้ครอบคลุมพ้ืนที่ เพิ่มจุดน้อย

มาก  

 

 
 

 

 

 

 

 

 

 

ตั้งค่า Build Mesh  

จากน้ันกด OK 
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3.6 การขั้นตอน Build Texture 

 เมื่อท าการประมวลผลข้อมูล mesh เสร็จเรียบร้อยแล้ว จากนั้นให้ท าการประมวลผลข้อมูล texture 

โดยให้เลือกค าสั่ง Build Texture เป็นขั้นตอนในการน าพ้ืนผิวของภาพมาใส่ในโมเดลของ ท าให้โมเดลมีสีสัน

สวยงามมีความละเอียดของเม็ดสีเพิ่มขึ้น 

 
 

กด Build Texture เพื่อการ

ประมวลผลข้อมูล Texture 
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การตั้งค่า Mappin Mode จะมีให้เลือกตามความเหมาะสม 

o Generic ท าให้ภาพมีสีทั่วไป 

o Orthophoto จะเน้นทางภาพ top view เพียงอย่างเดียว 

o Adaptive Orthophoto ก็จะเน้นทางภาพ top view และด้านข้างเล็กน้อยปรับให้พอดี 

o Spherical จะเน้นท าให้ภาพเป็นวงกลม 

o Single Camera จะเป็นการน าสีของภาพๆเดียวมาใส่ในโมเดลส่วนของภาพนั้นๆ 

การตั้งค่า Blending Mode การปรับสี 

o Mosaic (default) ซึ่งเป็นค่าเริ่มต้น 

o Average จะใช้ค่าเฉลี่ยของภาพพิกเซลของภาพ Max intensity จะเลือกภาพท่ีมีความ

เข้มข้นสูงสุดของพิกเซล Min intensity เลือกภาพที่มีความเข้มข้นต ่าสุดของพิกเซล 

o Disabled ทั่วๆไป 

 

 

 

 

ตั้งค่า Build texture  

จากน้ันกด OK 
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3.7 การท าจุดควบคุมภาพ (Ground Control Point: GCP) 

 เมื่อท าการประมวลทั้ง 4 ขั้นตอน แล้วเรียบร้อยแล้วจะท าการปรับความถูกต้องเชิงต าแหน่งของ

ข้อมูล 3 มิติ และข้อมูลความถูกต้องเชิงต าแหน่งของภาพ Orthophoto ให้มีความถูกต้องมากข้ึนกว่าเดิม โดย

การเพ่ิม Marker โดยคลิกขวาที่จุดที่เราทราบค่าต าแหน่งนั้นๆ ซึ่งเรียกวิธีการนี้ว่า การท าจุดควบคุมภาพ 

(Ground Control Point : GCP ) โดยการ เลือก Create marker เมื่อ create maker แล้วดูทางด้าน

ซ้ายมือในแถบ reference จะเห็นรูปธงสีฟ้าให้ตั้งชื่อจุดและกรอกใส่ค่าพิกัด x,y,z ถ้าหาแถบเครื่องมือไม่เจอ

ให้คลิกขวาที่บนแถบตามรูปแล้วเลือกเมนู reference สามารถเปิด/ปิด รูปธงได้ ตามไอคอนดังภาพรูปธง 

 

 
 

 เมื่อใส่ Marker ตามจ านวน GCP เรียบร้อยแล้ว ให้กด Save ให้กดตรง update ที่เป็น ไอคอนรูป

ลูกศรสีฟ้า จากนั้นกด Optimize camera รูปไฟฉายสีส้ม แล้วก็จะมีพารามิเตอร์ต่างๆ ให้เลือก จากนั้นกด 

OK โปรแกรมจะแสดงค่า error เชิงต าแหน่งที่ได้ท าการปรับแก้ หลังจากท่ีเราท าการ optimize camera 

เแล้ว ท าการประมวลผลภาพอีกครั้งหนึ่งโดยเริ่มจาก Dense Cloud > Mesh > Texture ถือเป็นการเสร็จสิ้น

กระบวนการประมวลขั้นพ้ืนฐาน  

 หมายเหตุ หากเกิดปัญหาหลังจาก optimize แล้วไม่สามารถขึ้นโมเดลได้มีการบิดหรือม้วน แสดงว่า

มีการใส่ค่าพิกัดใน marker ผิดหรือสลับต าแหน่งกัน ควรเช็คก่อนว่ามีค่า error เยอะเกินความจริงหรือไม่

หลังจากท่ีเรากด update ถ้าไม่มากเกินไปก็ optimize เพ่ือปรับแก้แต่ถ้ามากเกินไปควรเช็คดูค่าพิกัดแต่ละจุด

ว่ามีจุดไหนที่ค่า error เยอะ และพิจารณาตัดออกไป หากไม่สามารถแก้ไขได้ 
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3.8 การประมวลผลภาพ Orthomosaic 

 หลังจากการประมวลผลขั้นตอนหลักเสร็จแล้วนั้นถ้าเราต้องการ ภาพออโท ซึ่งเป็นภาพตั้งฉากที่มี

ความละเอียดสูงและมี ความถูกต้องเชิงต าแหน่ง โดยเราต้องไปเลือกค าสั่ง Workflow จากนั้นเลือกค าสั่ง 

Build Orthomosaic  

 
 

 
 

กด Build Orthomosaic เพื่อการ

ประมวลผลข้อมูล Orthomosaic 

ตั้งค่า Build Orthomosaic 

จากน้ันกด OK 
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 เมื่อประมวลเสร็จแล้ว ส่งออกข้อมูลภาพ orthomosaic โดยไปท่ี File > Export orthomosaic > 

Export JPEG/…> export แล้วเลือกไฟล์นามสกุลที่เราต้องการ หรือถ้าต้องการให้แสดงภาพซ้อนทับบน 

google earth ให้ File > Export orthomosaic > Export Google KMZ > export 

หมายเหตุข้อควรระวัง 

1.ประเทศไทย จะแบ่งโซนหลักๆ เป็น 2 โซน คือ 47 และ 48  

2.ใช้ระบบพิกัดของภาพเป็นระบบเดียวกันกับพิกัดของจุดควบคุมภาพ GCP  

การก าหนดค่าพิกัดให้เข้าไปที่ Projected Coordinate systems > world geodetic system 1984 > 

WGS 84 /UTM Zone 47Nเมื่อเลือกได้แล้วก็กด OK 

 

3.9 การประมวลผลภาพ Digital elevation model 

 หลังจากการประมวลผลขั้นตอนหลักเสร็จแล้วนั้น ท าการประมวลผลภาพ Digital elevation 

model ซึ่งเป็นภาพความสูงเชิงเลขที่จะบอกความสูงของพ้ืนที่ โดยเราต้องไปเลือกค าสั่ง Workflow จากนั้น

เลือกค าสั่ง Build DEM  

 

การตั้งค่าเพื่อ Export ข้อมูล 
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กด Build DEM เพ่ือการประมวลผล

ข้อมูล DEM 

ต้ังค่า Build DEM 

จากนัน้กด OK 
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3.10 การ Export ข้อมูลที่ได้จากการประมวลภาพถ่ายทางอากาศ 

 เมื่อท าการประมวลผลข้อมูลครับทุกประเภทแล้วนั้น ผู้ประมวลผลสามารถท าการ Export โดยให้ที่

ค าสั่ง File จากนั้นให้เลือก Export โดยจะสามารถ Export ข้อมูลได้ 5 ประเภทได้แก่  

  1. ข้อมูล Point 

  2. ข้อมูล Model 

  3. ข้อมูล Orthomosaic 

  4. ข้อมูล DEM 

  5. ข้อมูล Generate Report 

 
 

ขั้นตอนการ Export point 
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การตัง้ค่า Coordinate System 

กดเพื่อตัง้คา่ พิกดั X,Y,Z 
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บทที่ 4  
การวิเคราะห์ปริมาณขยะด้วยโปรแกรม Cloud Compare 

 โปรแกรม Cloud Compare เป็นโปรแกรมท่ีใช้ในการวิเคราะห์ข้อมูล Point Cloud โดยการน าเข้า

มูลทีได้จากกการประมวลผลในโปรแกรม Agisoft PhotoScan Professional Edition มาใช้วิเคราะห์ข้อมูลความสูง

ของพ้ืนผิว เช่น ความสูงของกองขยะ ความสูงของพ้ืนที่ นอกจากการวิเคราะห์ความสูงของพ้ืนที่ โปรแกรม 

Cloud Compare ยังสามารถวิเคราะห์ปริมาตรของกองขยะได้อีกด้วย 

ตารางที่ 4-1  ประเภทข้อมูลที่ใช้ร่วมกับโปรแกรม Cloud Compare 

ประเภทข้อมูล ประเภทไฟล์ 

Wavefront OBJ .OBJ 
Stanford PLY .ply 

XYZ Point Cloud .txt 

ASPRS LAS .las 
LAZ .las 

 

4.1 การท า Segment ข้อมูล Point Cloud  

 การท า Segment ข้อมูล Point cloud คือการตัดข้อมูลที่เราไม่ต้องการจะใช้ในการวิเคราะห์ออกให้

เหลือเพียงข้อมูลที่ต้องใช้วิเคราะห์เท่านั้น 

 4.1.1 น าเข้าข้อมูลไฟล์ .TXT  ที่ได้จากโปรแกรม Agisoft PhotoScan Professional Edition โดยตัว

ไฟล์ข้อมูลจะประกอบได้ค่าพิกัด X,Y และความสูงค่า Z  

 
 

กด open file 

เลือกชื่อไฟล์ที่ได้ Export จากโปรแกรม  จากนั้น

กด open 
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 4.1.2 การเลือกค าสั่ง Segment เพ่ือตัดข้อมูลเฉพาะพ้ืนที่กองขยะและน ามาใช้วิเคราะห์ความสูงของ

พ้ืนที ่และน าไปวิเคราะห์ข้อมูลปริมาณกองขยะ  

 
 

กด Apply all 

กดเลือกค าสั่ง Segment 



37 

การท า Segment จะใช้วิธีการ คลิกซ้าย และลากเส้นโดยรอบขอบเขตกองขยะที่ต้องการจะตัดข้อมูล

เมื่อลากครอบคลุมพ้ืนที่กองขยะแล้วให้ท าการ กดคลิกขวา 1 ครั้ง  

เมื่อท าการลากเส้นรอบพ้ืนที่กองขยะที่ต้องการจะตัดเรียบร้อยแล้วให้กดค าสั่งเครื่องหมายถูกสีเขียว 

สัญลักษณ์เส้นกรอบสีเขียวแสดงกรอบพื้นที่กอง

ขยะที่ถูกท า Segment 

เมื่อลากเส้นขอบเขตคลอบคลุมพื้นที่กอง

ขยะแลว้ให้กดเครื่องหมายถูกสีเขียว 
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4.2 การท า CSF Filter ของข้อมูล Point Cloud  
 การใช้งานค าสั่ง CSF Filter เป็นเครื่องมือที่ใช้ในการแยกข้อมูล Ground Point โดยจะใช้อัลกอริทึม

เพ่ือแยกพ้ืนที่ราบกับพ้ืนกองขยะออกจากกันท าให้สามารถวิเคราะห์ปริมาณของกองขยะได้อย่างถูกต้อง และ

รวดเร็ว 

 
 

 

 
 
 

 

กดเลือกค าสั่ง CSF Filter ในชุดค าสัง่ 

Plugins 

เลือกค าสั่งที่ใช้แยกพ้ืนราบกบักองขยะ 
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4.3 การท า Rasterize ของข้อมูล Point Cloud 
การใช้ค าสั่ง Rasterize เป็นค าสั่งที่น าข้อมูล Point Cloud มาสร้างชุดข้อมูลใหม่ 2 ชุดข้อมูลได้แก่ 

1) ข้อมูลความสูงเชิงพ้ืนผิว คือข้อมูลที่จะรวมความสูงของสิ่งปลูกสร้างหรือต้นไม้ที่โดรนนั้น

ถ่ายติดมาด้วยวิธีการที่จะตัดข้อมูลสิ่งปลูกสร้างหรือต้นไม้ ออกนั้นเราจะใช้ ค าสั่ง CSF Filterเข้ามาช่วยแยก

ข้อมูล 

2) ข้อมูลเส้นชั้นความสูง คือข้อมูลคือ เส้นที่แสดงลักษณะความสูงต ่าของพื้นที่ เป็นเส้น

จินตนาการของระดับที่คงที่บนพื้นผิวภูมิประเทศ ที่มีค่าระดับเท่ากัน เส้นชั้นความสูงที่มีค่าเป็นบวก คือเส้นที่

แสดงค่าความสูงเหนือระดับทะเลปานกลาง ส่วนเส้นชั้นความสูงที่มีค่าเป็นลบเป็นเส้นชั้นความสูงที่แสดงค่า

ความสูงต ่ากว่าระดับทะเลปานกลาง 
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4.4 การท า Volume ของข้อมูล Point Cloud 

การท าข้อมูล Volume คือการวิเคราะห์ปริมาณของกองขยะ ในการวิเคราะห์ข้อมูล Volume นั้น

ต้องใช้ข้อมูลที่ ผ่านการท า CSF Filter ก่อนจะน ามาใช้วิเคราะห์ปริมาณ Volume  
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